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Copyright

EVS Broadcast Equipment SA— Copyright © 2003-2014. All rights reserved.

Disclaimer

The information in this manual is furnished for informational use only and subject to
change without notice. While every effort has been made to ensure that the information
contained in this user manual is accurate, up-to-date and reliable, EVS Broadcast
Equipment cannot be held responsible for inaccuracies or errors that may appear in this
publication.

Improvement Requests

Your comments will help us improve the quality of the user documentation. Do not
hesitate to send improvement requests, or report any error or inaccuracy on this user

manual by e-mail to doc@evs.com.

Regional Contacts

The address and phone number of the EVS headquarters are usually mentioned in the
Help > About menu in the user interface.

You will find the full list of addresses and phone numbers of local offices either at the end
of this user manual (for manuals on hardware products) or at the following page on the
EVS website: http://www.evs.com/contacts.

User Manuals on EVS Website

The latest version of the user manual, if any, and other user manuals on EVS products
can be found on the EVS download center, on the following webpage:
http://www.evs.com/downloadcenter.
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What's New

In the Configuration Manual of the File Transfer Daemon the icon has been
added on the left margin to highlight information on new and updated features.

The changes linked to new features in version 3.7 are listed below.

The version of the application and the validity of the license are checked at
startup.

» See section "Version and License Check" on page "3".

The splash screen now also displays the database name and version and the date
until which the license is valid.

See section "Main Window Overview" on page "5"

The columns in the main window grid can now be re-arranged, hidden and made
visible again.

» See section "Reordering Columns" on page "11".
» See section "Hiding and Unhiding Columns" on page "10".

The settings have been rearranged and certain settings can only be configured in
the Configurator.

What's New
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1.

About the Application

General Description

File Transfer Daemon is an automated application that transfers the files to be archived
(video files, metadata XMLs, etc.) from the IPDirector nearline storage to the XenData
Cache where it will be picked up by the XenData archiving workflow. For restores it will
check when the restoring from LTO to the Cache is finished and then transport the file
back to the IPDirector nearline storage.

Workflow

The diagram below shows the interactions between IPDirector and the various IP2Archive
software components, and between the various IP2Archive software components and the
HSM system. When IP2Archive interfaces with SGL's FlashNet, Front Porch Digital's
DIVArchive or Atempo's Digital Archive, File Transfer Daemon is replaced by Tape
Storage Controller.
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1.1.

1.2.

After Installation

Double-click the File Transfer Daemon icon @B on the desktop of the application server
to start the application. You can also start the application by double-clicking the
executable file (.exe) in the installation folder.

The splash screen appears.

IPE Archive

File Transfer Daemon Yersion: 01.04

Logging on to as ...

The application logs into the database. Then, the Settings window appears allowing you to
configure the application.

See section "Settings Window" on page "12".
After Configuration

Double-click the File Transfer Daemon icon @ﬁ on the desktop of the application server
to start the application. You can also start the application by double-clicking the
executable file (.exe) in the installation folder.

The splash screen appears. The application logs into the database.

Then, the main window opens. Depending on the settings, the application will either
automatically start executing file transfers after a certain time interval, or you will have to
click the Start button first.

1. About the Application
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1.3. Version and License Check

Introduction

The version of the application and the validity of the application license will be checked
when the application logs into the IP2Archive database at startup. The status of the
version or the license that is returned is displayed on the application splash screen.

Logging on to as ..

Version and License Statuses

The following version and license statuses can be returned:

Status Description Color Action Required
Current The actual version of the application. no No action required.
color
The application starts
automatically.
Outdated = A newer version of the application red Click OK to start the
exists, but this version can still be application at once.
used.

The application version that should be
installed is displayed.

Obsolete ' A newer version of the application red
exists and must be used. This version
may not be used anymore.

The application version that should be
installed is displayed.

Undefined The version of the application is not black
defined in the MAD database.

By default, the
application starts
automatically after 10
seconds.

Click OK to continue.

The application shuts
down.

Click OK to continue.

The application shuts
down.

1. About the Application
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Status Description Color Action Required
Beta A test version. blue Click OK to start the
application.

By default, the
application starts
automatically after 10
seconds.

License The license period is about to expire. It | orange | Click OK to start the

About to | is shown in how many days the license application at once.
Expire will expire.
By default, the
Contact your system administrator or application starts
check the License Controller manual. automatically after 10
seconds.
License The license period has expired. The red Click OK to continue.
Expired date when the license expired is
displayed. The application shuts
down.

Contact your system administrator or
check the License Controller manual.

No Valid | There was no valid license found in the ' red Click OK to continue.

License database.
The application shuts

Contact your system administrator or down.
check the License Controller manual.

Maximum @ The maximum number of instances red Click OK to continue.

Licenses <NUMBER OF LICENSES> for the

Reached | license has been reached. The application shuts
down.

Contact your system administrator or
check the License Controller manual.

4 1. About the Application
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1.4. Main Window Overview

General Description
The main window displays the file transfers that are being or have already been

performed. It allows you to monitor the file transfer status and progress, check for
possible errors and retry failed transfers.

lHlustration

The main window contains the areas highlighted on the screenshot below:

Area Description

The table below describes the various parts of the main window:

Part Name Description

1. | Titlebar The Title bar displays the name of the application and the
software version number. Between square brackets the
instance of the application that was selected in the
settings appears. If no instance has been selected yet,
[Undefined] appears.

1. About the Application
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Part Name Description
2. Menu bar The Menu bar contains three menus: File, Settings and
Help.

3. | Start/Stop buttons | The Start/Stop buttons are used to manually start and
stop the application.

4, Status field The Status field displays the current status of the
application.
5. Transfers pane The Transfers pane gives an overview of the file transfers

that are being or have been executed by the application.
The status of each file transfer is displayed.

6. Log pane The Log pane lists application events and can be useful
when you are trying to verify that automations are working
correctly. The date and time of each event is displayed.
By default, this pane is hidden. To display it, click the
splitter bar.

Menu Bar

The menu bar contains three menus: File, Settings and Help.

File Menu

The File menu contains only one command: Exit. It is used to exit the application. Click
the File menu or use the keyboard shortcut keys ALT + F or F10 + F to openit. Click Exit
or use the keyboard shortcut key X to exit the application.

Settings Menu

The Settings menu does not contain any commands. It immediately gives access to the
application settings. Click the Settings menu or use the keyboard shortcut keys ALT + S
or F10 + S to access the settings.

Help Menu

The Help menu contains only one command: About. Click the Help menu or use the
keyboard shortcut keys ALT + H or F10 + H to open it.

With the About command the application about box can be opened. The about box
displays the application software version, the date until which the application license is
valid, the name and version of the database the application is logged on to and the login
name used.

Click About or use the keyboard shortcut key A to open the about box.

Note
These menus only become available after you have clicked the Stop button.

6 1. About the Application
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Logged on to [DatabaseName] as [Login]

Status Field

The Status field displays the current status of the application.

In Automatic Mode, the Status field will display the status AUTO at start-up, indicating
that the application will automatically start processing file transfer requests and executing
file transfers. After a certain time interval specified in the settings, the status will
automatically turn into Active.

In Manual Mode, the Status field will display the status INACTIVEat startup. If you then
click the Start button, the status will immediately turn into ACTIVE.

Warning
File Transfer Daemon cannot be exited while performing transfers. You will
have to click the Stop button first before you can exit File Transfer Daemon.

1. About the Application 7
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2.

2.1.

Monitoring File Transfers

File Transfer Data

The File Transfer pane displays the information about the file transfer jobs that have been
or that are being executed.

ByFile Transfer Daemon 3.6.0.1 - [undefined]

The table below describes the information that is displayed:

Data Description

Application Name of the File Transfer Daemon instance that is performing the file
transfer. This field is empty if the instance is undefined.

Created Time and date the file transfer job was requested.

Error Brief description of the error that occurred. This field is empty if there
are no errors.

Filename Name of the file to be transferred.

Filesize Size of the file to be transferred. This field is empty is the filesize is 0.

ID Unique identifier of the file transfer job.

Nb. Err. Number of times File Transfer Daemon transferred the requested file
unsuccessfully. This field is empty if the number of errors is 0.

Progress Progress bar displaying the progress of the file transfer. This field is
empty if the file transfer has not started yet.

Source Name of the source folder volume.

Started Date and time the file transfer started. This field is empty if the file
transfer has not started yet.

Status Status of the file transfer job.

Target Name of the target folder volume.

Time Duration of the file transfer. This field is empty if the file transfer has
not started yet.

Title Name of the file transfer job.

Type Type of transfer method used.

2. Monitoring File Transfers



CONFIGURATION MANUAL IP2Archive 1.4 File Transfer Daemon 3.7 | / I

2.2. File Transfer Status

Each file transfer can have one of the following statuses:

Status Color  Description

Abort Req. orange A request has been made to abort the file transfer.

Aborted olive The file transfer has been aborted.

Error red An error occurred during the file transfer.

Executed lime The file transfer has been executed successfully.

Failed purple | The file transfer has reached its maximum number of retries,

i.e. went in error the maximum number of times.

Other Appl blue The file transfer request has been assigned to another File
Transfer Daemon instance.

Processing yellow | The file transfer is being executed.

Requested white The file transfer has been requested and assigned to this
File Transfer Daemon instance.

Undefined gray The file transfer request has not yet been assigned to a
particular File Transfer Daemon instance.

2.3. Retrying File Transfer Errors

Sometimes, an error can occur during a file transfer. The file transfer job will go into error.
A Retry button and a detailed error description will appear.

B X

27-Jun-13 10:26: 0o 2 0 % errar 1 led
Error connecting

27-Jun-13 - 00 2 0 % error 1 |led
Error connecting t

27-Jun-13 10:26:4
27-Jun-13 10:26:4 00 2 0 % errar
Error connectin

error

27-Jun-13 10:26:4 00 2 0 % errar

Error connecting to destination 172.26.1.2

2. Monitoring File Transfers 9
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2.4,

If you click the Retry button, File Transfer Daemon will retry a number of times to perform
the file transfer job. The number of retries has been configured in the database and
depends on the type of error. The error code will be reset to 0 and the status will be set to
Requested again.

As long as the file transfer job has not failed, you can retry it. Once the file transfer job has
failed, the Retry button will no longer be available.

Hiding and Unhiding Columns

You can temporarily hide columns from a grid without having to remove them. Afterwards,
you can easily make them visible again.

How to Hide a Column

To hide a particular column from a grid, proceed as follows:
1. Click the Show/Hide/Move button Ea in the top left corner of the grid.

A drop-down list will appear with the available columns.

Ed Ord, Mame

2. Deselect the check box next to the header of the column you want to hide from the
grid.

How to Unhide a Column

To make a hidden column visible again, proceed as follows:
1. Click the Show/Hide/Move button E3 in the top left corner of the grid.

A drop-down list will appear with the available columns.

#

Crd, Mame

Ord,

s

¥ I
¥ D
¥
=

¥ [
¥ o

2. Select the check box next to the header of the column you want to make visible again.

10
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2.5.

Reordering Columns

If you want the information in a grid to be displayed in a different order, you can change the
position of the columns. There are two ways to reorder columns.

Using a Drag-And-Drop Action

To reorder a column by directly dragging its header, proceed as follows:

1.

Click the header of the column you want to move and hold down your left mouse
button.

Drag the column header to the desired position in the grid.

Two arrows will indicate where it is possible to insert the column.

Xx

A black prohibition sign will indicate where the column cannot be inserted.

3. Release the left mouse button to insert the column.

Using the Show/Hide/Move Button

You can also reorder the columns of a grid by using the Show/Hide/Move button:

1.

Click E on the left side of the first column header.

A drop-down list containing the headers of the grid columns appears. The column
headers are listed in the order in which the columns are displayed in the grid. The first
header in the list is the leftmost field in the grid. The columns that are visible in the grid
are selected.

The headers in the screenshot below can differ from the headers available in your
application.

EdOrd, Mame

" Last update
" Def, &k,

w
vl
il
w
w
il

2. Select a header and drag it to the desired position in the list. Green arrows will appear

indicating where you can insert the grid.

2. Monitoring File Transfers 11
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2.6.

n Ord, Mame
¥ Ord.

Settings Window

Opening the Settings Window
The Settings window allows you to configure your application. The first time the

application is launched after it has been installed, the Settings window opens
automatically.

Settings
User settings System settings
MAD

Walume + File A

To make this menu available, click the Stop button. The application will stop performing
its tasks.
Overview Setup Categories

The settings can be divided into two setup categories. In the Settings window, atabis
provided for each setup category. The table below briefly describes each setup category:

12
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Setup Category Description
User Settings These settings can be configured by each individual user.
System Settings These settings configure the general functioning of the

application. They can only be configured by the system
administrator.

2. Monitoring File Transfers

13



EVS Broadcast Equipment SA Issue 3.7.D - June 2014

Edit Mode

To be able to edit the System settings, you first have to enter a password.

To put the Settings window into Edit Mode, proceed as follows:

< Enter into edit mode

1. Click the Enter Into Edit Mode button

A dialog box appears.
Password Dialog

Enter password:

2. Enter the administrator password and then click OK.

The Settings window enters into Edit Mode.

Edit Mode

Note

Certain settings are read-only and cannot be configured. These can only be
modified in the Configurator application. Other settings have to be configured
locally.

2.6.1. Overview User Settings Subcategories

The System settings are divided into the following subcategories:
+ MAD

2.6.2. MAD Tab

The MAD tab allows you to configure how the name of the source and target location will
be displayed in the main window of File Transfer Daemon.

Wolume +

If you select the radio button:

* Volume, the name of the source, i.e. the storage area containing the file that has to be
transferred, will only contain the source storage volume name. The name of the target,
i.e. the storage area the file has to be transferred to, will only contain the target storage
volume name. By default, this option is selected.

14 2. Monitoring File Transfers
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2.6.3.

2.6.4.

* File Access, the name of the source will only contain the name of a specific folder on
the source storage volume. The name of the target will only contain the name of a
specific folder on the target storage volume.

* Volume + File Access, the name of the source will contain the name of the source
storage volume and a specific folder on this volume. The name of the target will
contain the name of the target storage volume and a specific folder on this volume.

Overview System Settings Subcategories

The System settings are divided into the following subcategories:
» Logging

* MAD Options

» Oracle Connection

+ E-Mail Options

« FTP

For each subcategory a tab is provided.

Logging Tab

The Logging tab allows you to configure the log file management by File Transfer
Daemon.

Share copy

Log Event Frequency: 10002

Configuring Log File Management

To be able to configure the log file management, you have to select the Log Files check
box in the Log Files group box. The other settings in this group box become available then.
Once you have selected this check box, File Transfer Daemon will generate a new log file
every day. By default, this check box is selected.

Inthe Log Files Directory field, you can enter the path of the log file storage folder
manually or you can browse for it by clicking k&d. The default log file storage folder is
edLogFilesDir.

In the Cleanup Period (Days) field you can enter a time interval (in days) after which File
Transfer Daemon will clean up the generated log files. By default, this is set to 32 days. If
you enter'0', the log files will never be cleaned up.

2. Monitoring File Transfers 15
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2.6.5.

Configuring Log Events Share Copy Transfers

In the Log Event Frequency field, you can specify after how many events alog is
displayed in the Log pane conveying the progress of the file share copies being performed.
By default, this is set to'1000'.

MAD Options Tab

The MAD Options tab allows you to configure the file transfer process.

n: File Transfer Daemon Instance

(Taly]

walume - Direckary - Aocess Type St Walume - Directary - Access Type

Global
[-1 = infinite]
Murmber D

MHumber O

Selecting File Transfer Daemon Instance

You first have to select the correct File Transfer Daemon instance from the Application
list. An overview will appear of the types of transfer configurations that will be processed
by this application.

In the Source column the following information is displayed: name of the source storage
volume — name of a particular folder on the source storage volume —file access type.

In the Destination column the following information is displayed: name of the target
storage volume — name of a particular folder on the target storage volume —file access
type.

In the Type column the type of file access used is displayed.

Configuring the Frequency of Automated Tasks

The Global group box allows you to configure the frequency of a number of automated
tasks.

Inthe Number Days Back field, you can specify how far back in time (in days) File
Transfer Daemon goes to process the file transfer requests in the database. By default,
this is set toinfinite, i.e. *-1’.

16
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2.6.6.

In the Request Data Delay field, you can specify how frequently (in seconds) File
Transfer Daemon will check the database for new file transfer requests. By default, this is
set to '60'".

If you select the Enable Auto Start check box, File Transfer Daemon will automatically
start processing file transfer requests at start-up. By default, this check box is not
selected. You can also specify the time interval after which File Transfer Daemon will
start processing the file transfer requests. By default, this is set to '10'.

In the Number Days Showing Failed field you can specify how long (in days) a failed file
transfer will stay visible in the File Transfer pane. By default, this is set to '0'.

In the Number of Transfers Shown field you can define how many transfer jobs at
maximum will be displayed in the File Transfer pane. By default, this is set to'20'.

If you have modified the default settings, you can restore them by clicking the Set to
Default Settings button. These settings have been configured in the Configurator
application.

Oracle Connection Tab

The Oracle Connection tab allows you to configure the connection with the Oracle
database.
Oracle login
: database name

gif name

Llze autologin

4 & pplication histary

interval ;

timne(s)

iy Test Dracle

Entering the Database Name

In this field you have to enter the name of the database the application has to connect to.

If the Use This Database Name check box is selected, the name of the database will
automatically appear in the Oracle login dialog box at start-up.

2. Monitoring File Transfers 17
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Entering the Login Name

In this field you have to enter a login name. If the Use This Login Name check box is
selected, the login name will automatically appear in the Oracle login dialog box at start-

up.

Entering a Password

In this field you have to enter a password. If the Use Auto Login check box is selected,
the application automatically logs into the selected database at start-up. The Oracle login
dialog box does not appear.

Checking Application History

By clicking the Application History button, you can open a chronological list of all
software versions of the application. To get more details about each version (creation
date, name of programmer, status, additional remarks), you have to click + next to the
version number.

Activating Keep Alive

If the option Keep Connection Alive is selected, a message is sent to the database at
regular time intervals to avoid idle connections from being closed by the firewall. These
intervals can be set by you.

If the option Try to Reconnect if Keep Alive Fails is selected, the application will try a
number of times to reconnect with the database.

If the option Report Status in Database Everytime Keep Alive Timer Triggers is
selected, the status of the connection is reported in the database each time the Keep
Alive Timer sends a trigger to send a Keep Connection Alive message.

If the option Report Status of Tasks is selected, the status of the tasks (ok or not ok) is
reported to the database.

Testing the Oracle Connection

The Test Oracle button allows you to check the validity of the database name, login and
username you entered.

If these data are valid, then the following message appears next to the Test Oracle
button: ‘OK’.

If the login name or password is invalid, then a message box appears with the following
message: ‘ORA-01017: invalid username/password; logon denied’.

If the database name is invalid, then a message box appears with the following message:
‘ORA-12154:TNS: could not resolve the connect identifier specified’.

If you omit the password, then a message box appears with the following message:
‘ORA-01005: null password given; logon denied’.

18
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2.6.7.

If you do not enter a database name, login and usemame, then a message box appears
with the following message: ‘ORA-12560: TNS: protocol adapter error’.

You can also check the software version of the application by clicking the Test Oracle
button. If the software version is up-to-date, then the following message appears:
‘Current— The Current Version'. If the software version is outdated, then the following
message appears: ‘Unknown Version Application! Please contact the EDP department.’

If you close the Settings window without testing the validity of the database name, login
and username you just entered, then a message box appears.

Information

If you click Yes, then the Settings window is closed and the original values are restored. If
you click Cancel, then the Settings window does not close and you can test the values by
clicking the Test Oracle button.

If you change the current database settings, test the connection and then close the
Settings window, a message box will appear.

Information

If you click Yes, the application is stopped and closed. A manual restart will be required.
Click Cancel to continue.

E-Mail Options Tab

In case the application is capable of sending e-mail messages, the E-Mail Options tab will
allow you to configure an e-mail account, enter the e-mail address of the default sender
and recipients, and enter a default e-mail subject. If the application is not capable of
sending e-mail messages, the settings in this tab cannot be used.

Send e-mail @ Send emal
F: zettings
Host identifier : ST login
Part :

Tine-out :

wternal mail settings

2. Monitoring File Transfers 19
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2.6.8.

To be able to configure the e-mail account, you have to select the Send E-Mail check
box. The fields in the Mail System Settings and Mail Message Settings group box become
available.

Configuring an E-Mail Account

In the Mail System Settings group box you have to enter the IP address and port number
of the SMTP server and specify a timeout. In the SMTP Login group box you can enter a
user name and password.

Configuring a Default E-Mail Message

The Mail Message Settings group box contains two tabs: Internal Mail Settings and
External Mail Settings.

The Internal Mail Settings tab can be used to configure a default e-mail message that will
be sent to the EVS developers and the customer when an error occurs.

The External Mail Settings tab can be used to configure a default e-mail message that will
be sent to the customer to notify him about an error. In each tab you have to enter the
sender’'s email address, the email address of the various recipients and a subject. It
should be noted that this tab is not always used.

When you insert multiple e-mail addresses in any of the header fields, make sure you
separate them by a comma.

To test the settings and manually send an e-mail message, click the Send Mail button.

For the new settings to take effect, close and restart the application. Check the TOM.ini
file in the installation folder of the application for the e-mail addresses and subject entered
here.

[General]

TemporaryFiles. Text=edtTemporaryFilesDir
Emailwanted. Checked=0

Port. Text=25

HOSTID. Text=

Timeout. Text=5000

SMTPLogin. Checked=1

Mailuser. Text=

MailPasswd. Text=ylcwaD8bs1hdK17uHg8knw==
MailPasswdunicode. Text=79CIGqDro,/FCDBASFhtZkw==
Mal [From. Text=

MailTo. Text=

MailCc. Text=

MailBcc. Text=
Mailsubject. Text=
ExternMailFrom. Text=
ExternMailTo. Text=
ExternMailCc. Text=
ExternMailBcc. Text=
ExternMailsubject. Text=
cb5avescreenbumpUnHand Tederrors. Checked=1
chsaveunforcederrors. Checked=1
cbsavescreenbumphandlederrors. Checked=1
chautomaticLogin. Checked=0
chuseknownDatabase. Checked=0
chuseThisLogin. Checked=0
chkkeepConnectionAlive.Checked=0
chkTryToreconnect. Checked=0

FTP Tab

The FTP tab allows you to configure the transfers of the type FTP.
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CONFIGURATION MANUAL IP2Archive 1.4 File Transfer Daemon 3.7 | / I

FTPUTF-8 led:

Log Event Frequency: 1000

The FTP buffer size is the size of the FTP Send/Receive buffer used in case of FTP
transfer. By default, this is set to'16'.

The FTP UTF-8 Enabled check box is an indication that UTF-8 support should be
enabled for the FTP transfers. This is needed for some Linux FTP servers. By default, this
check box is not selected.

In the Log Event Frequency field you can specify after how many events a log is
displayed in the Log pane conveying the progress of the FTP transfers. By default, this is
set to '1000'".

If you have modified the default settings, you can restore them by clicking the Set to
Default Settings button. These settings have been configured in the Configurator.
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